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Migrating an Existing Octel Messaging System to a Pentium PC for
Release 3.2

This note provides the steps for migrating an existing messaging system to a Pentium-
level PC for use with Octel 100 Version 3.2.

Steps for upgrading the messaging software to Octel 100 3.2 are provided in a separate
note. You must complete the procedure contained in this note to migrate to a Pentium
PC platform, if required, before you upgrade the software.

Required Materials

The following materials may be required for the migration. Make sure that you have the
required materials available before beginning the migration:

A medium you can use to back up files on the system, such as diskettes or a
tape backup device (make sure that the medium you select is supported on both
PCs)

¢ Any hardware required to upgrade the system, including voice or fax boards,
RAM, or a Sentinel device, as well as accessory tools you may need, such as a
screwdriver

e A sentinel upgrade utility (SUU) or a new Sentinel, if required

e An anti-static wrist strap, if you will be handling voice or fax boards

¢ LinkWiz software and parallel cable

¢ The PC manufacturer's documentation, if you are upgrading RAM

¢ Octel 100 Version 3.2 Implementation and Service Manual

Procedures in this note assume that the hard drive on which the system is installed is
drive C, that any additional hard drive that may be installed is D, that the disk drive is A,
and that the CD-ROM drive, if installed, is E. Drive designations on the specific PC on
which you are working may vary. Confirm the appropriate drive letters, when necessary,
in procedures provided in this note.
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MIGRATING AN EXISTING OCTEL MESSAGING SYSTEM TO A PENTIUM PC

Determining Whether Migration to a New PC is Required

The following table provides the minimum CPU and memory requirements for Octel 100
Version 3.2. The current messaging system PC must meet these requirements for use
with Octel 100 3.2. If the current messaging system PC does not meet these
requirements, you must migrate the messaging system to a new PC.

Information on systems with more than 16 ports is only supported for existing systems in
which more than 16 ports are already installed.

Voice System without Visual System with <50 Visual System with 50 - 250 Visual
Ports Mailbox Mailbox Clients Mailbox Clients
4 486 /33 w/ 16 MB RAM 486 /33 w/ 16 MB RAM 486 /66 w/ 16 MB RAM
8 486 /33 w/ 16 MB RAM 486 /33 w/ 16 MB RAM 486 /66 w/ 16 MB RAM
12 486 /33 w/ 16 MB RAM 486 /100 w/ 16 MB RAM 486 /100 w/ 16 MB RAM
16 486 /33 w/ 16 MB RAM 486 /100 w/ 16 MB RAM 486 /100 w/ 24 MB RAM
20 486 /33 w/ 24 MB RAM 486 /100 w/ 24 MB RAM 486 /100 w/ 24 MB RAM
24 486 /33 w/ 24 MB RAM 486 /100 w/ 24 MB RAM 486 /100 w/ 24 MB RAM
28 486 /100 w/ 24 MB RAM 486 /100 w/ 32 MB RAM P100 w/ 32 MB RAM
32 486 /100 w/ 24 MB RAM 486 /100 w/ 32 MB RAM P100 w/ 32 MB RAM

Contact a technical support representative if you are not sure whether a PC migration is
required before you attempt the software upgrade. If a PC migration is required,
complete the following procedure to transfer files on the current Octel system to the new
PC.

In this procedure, the existing Octel system is referred to as the “current messaging
system.” The PC to which you are transferring the existing Octel system is referred to as
the “new messaging system.”

WARNING: Use caution when handling boards, such as voice boards or network
interface cards, as they are electrostatic-sensitive. Be sure you ground
the PC, the work area, and the ground end of the antistatic wrist strap
prior to handling a board, and always use antistatic wrist straps and/or

electrostatic-dissipative mats while handling a board.

Step 1. Shutting Down the Current Messaging System

Use the following procedure to shut down the current messaging system, if it is running.

To shut down the current messaging system:

1. Log into the current messaging system as a Level 2 or 3 supervisor.

2. To shut down the system, select Exit from the File menu. A dialog box displays
prompting whether you want to shut down the system.

3. Click OK to perform the shutdown. A dialog box displays prompting you to wait for
channel activity to cease. Do not click Force. When all the ports are inactive, the
system shuts down.

101-1880-000
585-313-143

CoMcoDE 108623232 2
NOVEMBER 1999, IssuE 1
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Step 2: Testing the UPS

Use the following procedure if the current messaging system is connected to a UPS.

To test the UPS:

1.
2.

Unplug the UPS power cord from the electrical outlet.

Verify that the current messaging system continues to run (the UPS will beep to
indicate that it is supplying power to the PC).

If the PC turns off when you remove the UPS power cord from the electrical outlet,
verify that the UPS is connected properly. If the UPS is connected properly, contact
a technical support representative.

Plug the UPS power cord back into the electrical outlet.

Step 3: Running Quick Assist Update Partial on the Current
Messaging System

Use the following procedure to run Quick Assist Update Partial on the current messaging
system.

To run Quick Assist Update Partial:

1.
2.

10.

Double-click the Octel icon to open the Octel folder.

Double-click the Quick Assist icon in the Octel folder. The Quick Assist dialog box
displays.

Click Recover Files. The Recover Files dialog box displays.

In the Drive where \cvrl files are located field, verify that the displayed drive is the
drive where the \CVR1 directory is located.

In the Mailbox to receive unattached messages field, enter the mailbox in which you
want the system to place messages with invalid header information. (Unattached
messages with valid header information are placed in the new message queue of the
receiving mailbox.) Messages are only put in this mailbox if the Delete unattached
messages option is disabled.

Under Recovery Mode, select the Update (partial) option.

Under Recovery Options, select the Ask before creating a mailbox option if you want
the system to prompt you for confirmation before it creates mailboxes. The system
creates mailboxes when it finds messages or greetings that are linked to a mailbox
number that does not exist. If you deselect this option, the system automatically
creates the mailboxes indicated by the message or greeting links.

Under Recovery Options, select the Delete unattached messages option if you want
the system to automatically delete unattached messages. If you disable this option,
unattached messages with valid header information are placed in the mailbox in the
message header, and unattached messages with invalid header information are
placed in the mailbox you specified in step 4.

In the Report Filename field, enter the name of the report you want the system to
generate. The default is QASSIST.RPT.

Under Report Options, select the Send to File option if you want to create a report
file. When you select this option, the system creates a report with the specified
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11.

12.

13.

14.
15.

16.

17.
18.
19.

filename in the \CVR1 directory. If you deselect this option, the report is only
available by selecting the View Report option.

To begin the update, click Start. The Recover Status dialog box displays. The
system copies the files in the \CVR1 directory into a directory named \~REPAIR~.
Do not delete the files from the \~REPAIR~ directory until you are confident the
system has corrected any file damage.

The Searching Directory and Processing Mailbox fields display the directory and
mailbox currently being processed. The Errors and Warnings fields reflect the
respective number of errors and warnings the system encounters during the update.

When the partial update is complete, you can click Edit Mailboxes to reenter or
modify information that may have been lost. The Mailbox Quick Edit dialog box
displays with information for the first mailbox.

This dialog box includes general identification information about each system
mailbox, including the First and Last Name, Company, and Division. The Messages
box displays the number of recovered New and Saved messages.

You can click the Next and Previous buttons to move through the mailboxes. Click
Save to save any edits you make. When you finish making any edits, click OK to
return to the Recover Status dialog box.

Click OK. The Recover Files dialog box displays.

To display the report, click View Report. If the system detected errors or warnings
during the update, the appropriate corrective action is suggested in the report. If
Quick Assist recommends further action, such as performing an Update All or
Rebuild All, contact a technical support representative before continuing.

When you finish viewing the report, click the window icon in the upper-left corner
and select Close. The Recover Files dialog box displays.

Click Cancel. The Quick Assist dialog box displays.
To close Quick Assist, click Exit.

Double-click the icon in the upper-left corner of the folder window to close it.

Step 4: Modifying the Current Messaging System’s COM Port
Assignments

The new messaging system has new COM Port assignments for the UPS Integrator and
for Serial integration. If the current messaging system is using either the UPS Integrator
or Serial Integration, complete the following steps to modify the COM Port assignments
as necessary for the migration.

To modify the UPS Integrator COM Port settings:

1.
2.

Press <CTRL+ESC> to open the Window list.

From the Window List, double-click on UPS Integrator. The UPS Integrator dialog
box displays.

From the Options menu, select Setup. The UPS Setup dialog box displays.
In the Port field, change the setting to 1.
Click Save, then click OK. The UPS Setup dialog box displays.
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6.

Double-click the icon in the upper-left corner of the dialog box to close the UPS
Integrator.

To modify the SI.CFG file for systems running Serial integration:

1.
2.

© N o v

Open an OS/2 window.

From the C: prompt, type E C.\ CVR\ Sl . CFG and press <ENTER>. The contents
of the SI.CFG file display. The first line of the file should identify the PORT setting.

Place the cursor after the current COM Port number (you can press <END> to place
the cursor at the end of the first line), press <BACKSPACE> to delete the current
number, and type 4.

Select Save from the File menu. If this is the first time you have saved the file, the
Save Notification dialog box displays.

Click Type. The Type dialog displays.

Click Plain Text, then click Set. The file is saved.

Double-click the icon in the upper-left corner of the window to close the editor.
To close the OS/2 window, type EXI T and press <ENTER>.

Step 5: Shutting Down Any Open Applications

Use the following procedure to shut down any open applications on the current
messaging system.

To shut down any open applications on the current messaging system:

1.
2.

Press <CTRL+ESC> to open the Window menu.

Highlight any application with the exception of the OS/2 desktop or the LaunchPad.
(Some systems will not have a LaunchPad.)

Click the right mouse button once on the highlighted application.

Select Close.

Repeat steps 2 — 4 for each application listed in the Window menu.

Step 6: Preparing the PCs for the File Transfer

Use the following procedure to prepare the PCs for the file transfer.

To prepare the PCs for the file transfer:

1.

If a printer is attached to the current messaging system, unplug the printer’s parallel
cable from the back of the Sentinel.

Remove the Sentinel from the parallel port of the current messaging system.
Connect the LinkWiz cable to both PCs:

a. Connect one end of the LinkWiz parallel cable to the parallel port of the current
messaging system.

b. Connect the other end of the LinkWiz parallel cable to the parallel port of the
new messaging system.
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4. Turn on the new messaging system PC. When the new messaging system starts,
you will notice that OS/2 Warp 4.0 is installed. Standard tasks, such as opening an
0OS/2 window, are the same on Version 4.0 as for Version 3.0. An overview of the
most commonly performed OS/2 tasks in provided in Chapter 1, “Implementation and
Service Overview,” of the Implementation and Service Manual.

Step 7. Performing the File Transfer

Use the following procedure to perform the file transfer.

To perform the file transfer:

1. Launch the file transfer on the new messaging system:

a. Insert the disk labeled “Migration Diskette for New Computer” into the disk drive
of the new messaging system PC.

b. Open an OS/2 window. The C: prompt displays.

c. From the C: prompt, type MD M GRATE and press <ENTER>. A new directory
named MIGRATE is created on the C: drive.

d. From the C: prompt, type CD M GRATE and press <ENTER>. The \MIGRATE
directory prompt displays.

e. From the \MIGRATE directory prompt, type XCOPY A: and press <ENTER>.
The contents of the disk are copied to the \MIGRATE directory.

f. From the \MIGRATE directory prompt, type NEWCOVP and press <ENTER>.
Note that the file transfer activity is not displayed on the new messaging system
PC.

2. Launch the file transfer on the current messaging system:

a. Insert the disk labeled “Migration Diskette for Old Computer” into the disk drive
of the current messaging system.

b. On the current messaging system, open an OS/2 window. The C: prompt
displays.

c. From the C: prompt on the current messaging system, type A: and press
<ENTER>. The A: prompt displays.

d. From the A: prompt, type OLDCOMP and press <ENTER>. There will be a slight
delay before the file transfer begins. The following directories will be transferred
from the current messaging system to the new PC: CVR, CVR1, RECOO0 through
RECO09, and FAXO00 through FAX09. The files are listed onscreen on the current
messaging system as they are transferred. Only directories containing files are
transferred. Note that as each directory is copied, the PCs disconnect then
reconnect.

The file transfer may take up to 2 hours depending on the size of the database,

the number of backups, etc. When the transfer is finished, the message “File
transfer complete” displays on both PCs.

3. Once the file transfer is complete, verify that all necessary files were copied by
comparing the “bytes used” in each of the copied directories on both PCs. For
example, to compare the \CVR directories:

a. Onthe current messaging system, from the A: prompt, type C. and press
<ENTER>. The C: prompt displays.

b. From the C: prompt, type CD CVR and press <ENTER>. The \CVR directory
prompt displays.
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From the \CVR directory prompt, type DI R and press <ENTER>. The contents
of the \CVR directory on the current messaging system display.

On the new PC, from the \MIGRATE directory prompt, type CD. .\ CVR and
press <ENTER>. The \CVR prompt displays.

From the \CVR directory prompt, type DI R and press <ENTER>. The contents
of the \CVR directory on the new messaging system display.

Compare the number of bytes used in each directory. If they are not the same,
contact a technical support representative. If a directory on the new system is
empty, repeat steps 1f and 2d to re-run the batch files on both systems. The files
that have already been successfully transferred will generate an error message
that the file already exists on the new system. Verify that the directory that was
not copied is successfully migrated to the new system.

The number of files on the new messaging systems may be slightly different than the
number of files on the current messaging system because not all subdirectories are
copied to the new messaging system. This does not affect messaging system
operation.

Remove the migration diskettes from both the current messaging system and the
new messaging system.

If a tape backup is installed in the current messaging system to perform regular
backups and a tape backup is installed in the new messaging PC, you must copy the
.CMD and .FSS files to the new messaging system PC:

a.
b.

Insert a blank, formatted disk in the disk drive of the current messaging system.

From the \CVR prompt in the OS/2 window on the current messaging system
PC, type CD.. and press <ENTER>. The C: prompt displays.

From the C: prompt, type COPY C:\ BACKMAST\ FSS\ *. FSS A: and press
<ENTER>. The file is copied to the disk.

From the C: prompt, type COPY C:\ BACKMAST\ *. CMD A: and press
<ENTER>. The file is copied to the disk.

Remove the disk from the current messaging system and insert the disk in the
new messaging system.

From the \CVR prompt in the OS/2 window on the hew messaging system PC,
type CD.. and press <ENTER>. The C: prompt displays.

From the C: prompt, type COPY A:\*. FSS C:.\ BACKMAST\ FSS and press
<ENTER>. The .FSS file is copied to the new messaging system PC.

From the C: prompt, type COPY A:\*. OVMD C:\ BACKMAST and press
<ENTER>. The .FSS file is copied to the new messaging system PC.

Shut down the current messaging system PC:

a.
b.

To close the OS/2 window, type EXI T and press <ENTER>.

Click the right mouse button on an empty area of the desktop and select
Shutdown from the menu that displays. When you are prompted whether you
want to close all windows and active programs, click OK.

When prompted that the shutdown is complete, turn off power to the PC.
Disconnect the LinkWiz cable from the parallel port.

Disconnect the PC from the UPS, if the system is connected to a UPS. If you
were using UPS integration, you must also unplug the serial communications
cable.
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10.

11.

f. If the current messaging system is enabled for Visual Mailbox and a token ring
card is installed in the PC, you must remove it so that it can be installed in the
new messaging system PC:

i.  Unplug the network connection cable or jack from the token ring card.
iil. Remove the cover from the current messaging system PC.
iii. Unfasten the retaining screw from the token ring card’s metal bracket.
iv. Remove the token ring card from the PC.
v. Replace the PC's cover.

Verify that the new messaging system is set to the correct time:

a. Inthe OS/2 window, type TI ME and press <ENTER>.

b. Verify that the time displayed is correct:

» If the time displayed is correct, press <ENTER>.

» If the time displayed is incorrect, enter the new time in HH:MM format and
press <ENTER>.

To close the OS/2 window on the new messaging system, type EXI T and press
<ENTER>.

If the person or group who will be maintaining the messaging system owns an RSM
Manager license, you must set up the new messaging system PC to recognize the
Manager. Complete step 56 in the topic, “Installing the Remote Services
Management Software,” in Chapter 6, “Installing the Software,” in the Implementation
and Service Manual.

Disconnect the LinkWiz cable from the parallel port on the new messaging system
and attach the Sentinel to the parallel port.

Proceed with the software upgrade on the new machine.
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